Smart Art
This type of graphic is a visual representation of information that can be created quickly and
easily. Smart Art can be created using Word, Excel, PowerPoint, and in an Outlook e-mail
message. Smart Art graphics can be copied and pasted into Office versions earlier than Office 2010.
However, they cannot be created in the earlier versions.
When a Smart Art graphic is created, a prompt asking for the type of graphic to create appears. A
type is similar to a category of graphics. Within each of these types, there are several different
layouts. After a layout is chosen, it is possible to change the layout. Most of the text and other
content, such as colors, styles, and text formatting, are automatically carried over to the new
layout. These features can also be changed for each graphic.
CREATE SMART ART GRAPHIC
 Click the Insert Tab.
 In the Illustrations Group, click the Smart Art button.

 A gallery of Smart Art graphics will appear (see illustration).

 The table below provides a description of each of the graphic types.
Graphic Type Purpose of Graphic
All
This option provides a gallery of all the Smart Art graphics that are available.
For a list of layout names and descriptions of each of the SmartArt types, go to
Description of SmartArt graphics. A list of each layout type will display. Click
the link to display a list with a description of graphics for the selected type.
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Graphic Type
List

Process

Cycle

Hierarchy
Relationship

Matrix

Pyramid

Picture
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Purpose of Graphic
This type of graphic is used to show non-sequential information. This type of
SmartArt groups information that does not follow a step-by-step or sequential
process. These layouts usually don’t have arrows or a directional flow.
Choose this graphic type to show steps or stages in a process or workflow.
This layout should be used to show steps or phases that follow one another to
produce a result. A process in vertical steps, horizontal steps, or a bending
combination are shown with this layout.
To show a circular or repetitive process, choose this layout. These layouts can
be used to show teaching cycles, repeated or ongoing processes, such as a
continuous writing and publishing cycle, or a performance review cycle.
Use this graphic type to show a decision tree, a family tree, a family of
products, or to create an organizational chart.
To show conceptual relationships or connections between two or more sets of
things, select these layouts. A good example of a Relationship layout is a Venn
diagram. This diagram shows how areas or concepts overlap and come
together at a center intersection.
This type of graphic is used to show how parts relate to a whole or to a central
concept. Choose these layouts if four or fewer key points are to be presented
and a large amount of text is to be used.
Choose this type of graphic to show the proportional or hierarchical
relationships that typically build upward. These layouts work best with
information that is to be shown from top to bottom or from bottom up.
These layouts are used when a picture needs to be used to convey a message
with or without explanatory text. They can also be used to complement a list
or process.
This area provides additional layouts from the Office.com Web site. These
layouts are updated periodically with new layouts.

Click one of the Categories in the left frame to select it.
Click one of the Graphics in the middle frame to select it.
A diagram of the graphic will appear in the right frame.
Click OK to insert the graphic into the document.
The graphic will appear in the worksheet (see illustration below).
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To display the Text Pane, click the arrow on the left side of the image.
 The Text Pane is the area where the labels for the boxes can be input.
 It is also possible to input the information directly into each text box.
In the Text Pane in the left frame (see illustration above left), click the first text box.
Input the information that should go into the first box.
The information will appear in the Text area of the image.
Click each of the text boxes to input the appropriate information.
To add additional boxes, press the Enter key on the keyboard.
To change the level, do one of the following:
 To move in one level, press the Tab key.
 To move back one level, hold down the Shift key and then press the Tab key.
As text is entered into the Text Pane, the text will appear in the graphic.
The size of the text will change to accommodate the entry.

SMART ART GRAPHICS DESIGN TAB
After a graphic has been created, it is possible to make format changes. This is done by using
the Smart Art Tools tab. In this area, it is possible to choose from Design and Format. The
table below provides a description of each the groups and buttons on the Design Tab.

Group/Button
Create Graphic Group
Add Shape

Add Bullet
Text Pane
Promote

Demote

Right to Left
Move Up

Description
This group is used to add additional shapes to the graphic, to make
changes to the layout, and to display the text pane.
Click this button to add a new shape to the graphic. When the
button alone is clicked, a new shape will be added below the
selected box.
To add a bullet to the graphic, click this button. This feature is only
available if the graphic supports the use of bullets.
To toggle between displaying the Text Pane and not displaying the
Text Pane, click this bullet.
This button is used to change the level of the selected bullet or
shape. One of the shapes in the graphic must be selected in order to
activate this button.
Use this butt on to change the level of the selected bullet or shape.
One of the shapes in the graphic must be selected in order to
activate this button.
Use this button to switch the orientation of the graphic from right to
left and left to right.
This button is used to move the selection forward in the sequence.
One of the shapes in the graphic must be selected in order to
activate this button.
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Group/Button
Move Down

Layout
Layouts Group
Layout Gallery
More Button
Smart Art Styles Group
Change Colors

Styles Gallery

More Button
Reset Group
Reset Graphic

Convert to Shapes

Description
To move the selection backward in the sequence, click this button.
One of the shapes in the graphic must be selected in order to
activate this button.
Click this button to change the branch layout for the graphic. This
feature is only available when an organization chart is created.
To change the layout for the graphic, use this group.
Click this button to change the layout for the graphic. The arrows at
the end of the gallery are used to move between rows.
This button is used to show additional layouts for the graphic. It
appears at the bottom of the arrows on the right side of the gallery.
To change the style for the Smart Art, use this group. In this group,
it is possible to change the colors and the style.
To change the color of the shapes in the graphic, click this button. A
gallery of different options that are available for the chosen theme
will appear. Move the mouse pointer over each of the items to see a
Live Preview of the color.
To select a different style for the graphic, click one of the styles in
the gallery. To see additional styles, click the top and bottom arrow
on the right side of the gallery.
Click this button to display all the styles at one time. Move the
mouse pointer over each one to see a Live Preview of each style.
This group is used to set the graphic back to its original format and
to convert the graphic to a shape.
When this button is clicked, all the changes that were made to the
Smart Art graphic will be discarded. The graphic is returned to the
original format.
This feature is used to convert a SmartArt graphic into shapes so
that each shape can be moved individually.

SMART ART GRAPHICS FORMAT TAB
After a graphic has been created, it is possible to make format changes. This is done by using
the Smart Art Tools tab. The table below provides a description of each the groups and
buttons on the Format Tab.

Group/Button
Shapes Group
Edit in 2-D
Change Shape
Larger

Description
This group is used to change the shapes within the graphic.
Click this button to edit a 3-D graphic in 2-D. This feature is only
available if a 3-D style has been applied to the graphic.
This button is used to change the shape in a graphic. The shape must
be selected before this feature will activate.
To increase the size of a selected shape, click this button.
4

Group/Button
Smaller
Shape Styles Group
Styles Gallery
Shape Fill
Shape Outline
Shape Effects
Format Shape: Shape
Options Dialog Box
Launcher
WordArt Styles
Styles Gallery
Text Fill

Text Outline
Text Effects

Format Shapes: Text
Effects Dialog Box
Launcher
Arrange
Bring Forward

Send Backward

Selection Pane

Align

Description
Click this button to decrease the size of a selected shape.
To change the style attributes for the graphic, use this group.
To change the style of a selected shape, click this button. If the shape
is not selected, this option will not be available.
Click this button to fill the selected shape with a solid color,
gradient, picture, or texture.
To change the line color, width, and line style; click this button.
This button is used to apply a visual effect such as a shadow, glow,
reflection, or 3-D rotation to a selected shape.
To make additional changes to the shape, click this button. The
Format Shape Task Pane will display with the Shape Options pane
selected. This button is located in the bottom right corner of the
Shape Styles Group.
When WordArt has been inserted into a Worksheet, this group is
used to apply different formatting attributes.
To apply a new style to the selected text in a shape, click this button.
Click the More button to display additional styles.
Click this button to fill the selected text with a different color,
gradient, picture, or texture. The text must be selected for this option
to work.
To change the line color, width, and line style of the selected text,
click this button.
This button is used to apply a visual effect such as a shadow, glow,
reflection, or 3-D rotation to the text. The text must be selected for
this option to work.
To make changes to text properties, click this button. The Format
Shape Task Pane will display with the Text Effects pane selected.
This button is located in the bottom right corner of the WordArt
Styles Group.
This group is used to apply options such as alignment to a graphic.
When the list arrow is selected, a ribbon of commands will appear.
Use this button when an image is behind another image and needs
to be brought to the front. Click the list arrow to the right of the
button to select from Bring Forward, Bring to Front, or Bring in
Front of Text.
When an image appears on top of another image and needs to be
sent to the back of the image, click this button. Click the list arrow to
select from Send Backward, Send to Back, or Send to Back of Text.
This button is used to display the selection pane. In this pane, it is
possible to select different objects and/or rearrange the order of the
objects.
In order to align a group of images at the top, bottom, right, or left,
click this option. If only one image is selected, the image will be
arranged to the specified location on the page.
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Group/Button
Group

Rotate
Size
Height

Width

Size and Properties
Task Pane Launcher

Description
This option is used to combine a group of images so they can be
formatted as one image. With a SmartArt image, this button can be
used to Ungroup the image.
Click this button to rotate the image to a different orientation. It is
possible to specify the degree of rotation.
To change the height and width of the graphic, click this button.
This option is used to change the Height of a shape. To change both
the Height and the Width at the same time, change the Height then
press the Enter key. The Width will change as well.
Use this option to change the Width of the shape. To change the
Height at the same time, input the Width and then press the Enter
key. To change just the Width, input the Width then click within the
worksheet.
To display the Format Shape: Size and Properties Task Pane, click
this button. This Task Pane can be used to change the size of the
shape as well as to change other properties for the shape.

6

